
Excel Tutorial 5: Working with Excel Tables, PivotTables, and PivotCharts

TRUE/FALSE

1. The header row must be row 1.

ANS: F PTS: 1 REF: EX 234

2. If you freeze the top row in a worksheet and press Ctrl+Home, you will return to the cell directly 
above the frozen row.

ANS: F PTS: 1 REF: EX 238

3. You can create at most one Excel table in a worksheet.

ANS: F PTS: 1 REF: EX 239

4. When you create a table, if your data does not contain column headers, Excel adds headers with 
default names.

ANS: T PTS: 1 REF: EX 239

5. The simplest and most convenient way to add a record to a table is to enter the data in the first blank 
row below the last record.

ANS: T PTS: 1 REF: EX 242

6. You can use a table’s sizing handle to add columns or rows to a table.

ANS: T PTS: 1 REF: EX 242

7. To rearrange records in a list, you sort based on the data in one or more of the fields.

ANS: T PTS: 1 REF: EX 245

8. Before you complete a sort, you need to decide whether you want to put the list in ascending or 
descending order.

ANS: T PTS: 1 REF: EX 244

9. When you delete a record from a table, a dialog box displays to confirm the delete operation.

ANS: F PTS: 1 REF: EX 244

10. An easy way to sort data when there is only one sort field is to use the Sort A to Z or Sort Z to A 
buttons.

ANS: T PTS: 1 REF: EX 244

11. If a column consists of day or month labels, you can sort them in their correct chronological order 
using one of the predefined custom lists.
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ANS: T PTS: 1 REF: EX 248

12. When you filter your data, all records that do not meet your criteria are temporarily hidden from view.

ANS: T PTS: 1 REF: EX 252

13. You click a filter arrow to open the AutoFilter menu for a field.

ANS: T PTS: 1 REF: EX 252

14. Records have been filtered in the list shown in the accompanying figure.

ANS: T PTS: 1 REF: EX 253

15. When you clear a filter, all filters in the worksheet are cleared.

ANS: F PTS: 1 REF: EX 255

16. Excel can summarize data in a range of data by inserting subtotals.

ANS: T PTS: 1 REF: EX 263

17. You can format cells in a PivotTable the same way as you do cells in the worksheet.

ANS: T PTS: 1 REF: EX 276

18. The PivotTable Field List enables you to change, or pivot, the view of the data in the PivotTable by 
dragging the field buttons to different areas in the layout section.

ANS: T PTS: 1 REF: EX 277

19. You can change the alignment of the column headings for better placement and readability.
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ANS: T PTS: 1 REF: EX 281

20. To show items hidden in a PivotTable, you click the Show tab and check the check box for the item 
you want to show.

ANS: F PTS: 1 REF: EX 281

MODIFIED TRUE/FALSE

1. Each column represents a record that describes some attribute or characteristic of a person, place, or 
thing. _________________________

ANS: F, field

PTS: 1 REF: EX 234

2. The row of field names across the top of an Excel list is referred to as the header row. 
_________________________

ANS: T PTS: 1 REF: EX 234

3. Table names cannot include underscores. _________________________

ANS: F, spaces

PTS: 1 REF: EX 240

4. The QuickFix button shown in the accompanying figure enables you to undo table formatting if, for 
example, you had not intended new data to be part of an existing table. _________________________

ANS: F, AutoCorrect Options

PTS: 1 REF: EX 242

5. Ascending order arranges labels alphabetically from A to Z. _________________________

ANS: T PTS: 1 REF: EX 244

6. The fields you use to order the data in a list are sort fields. _________________________

ANS: T PTS: 1 REF: EX 245
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7. The first sort field in a sort is called the major sort field. _________________________

ANS: F, primary

PTS: 1 REF: EX 245

8. To create a custom list, in the Sort & Filter group on the Home tab, click the Sort button. Click the 
Order arrow, and then click Custom List. _________________________

ANS: F, Data

PTS: 1 REF: EX 248

9. If a column consists of day or month labels, you can sort them in their correct chronological order 
using one of the predefined custom lists. _________________________

ANS: T PTS: 1 REF: EX 248

10. You can display or hide filter arrows for an Excel table or a range of data by using the Filter button in 
the Sort & Filter group on the View tab. _________________________

ANS: F, Data

PTS: 1 REF: EX 252

11. Custom filters enable you to specify various conditions in addition to those that are based on an 
“equals” criterion. _________________________

ANS: F, Criteria

PTS: 1 REF: EX 256

12. Referring to the figure above, the phrase “is greater than” is the criteria for the first condition.  
________________

ANS: F, operator

PTS: 1 REF: EX 258
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13. You can calculate sort statistics (including sum, average, count, maximum, and minimum) on all the 
columns in an Excel table.  _________________________

ANS: F, summary

PTS: 1 REF: EX 259

14. The Summary command automatically inserts a subtotal line into the list for each group of data in the 
list. _________________________

ANS: F, Subtotal

PTS: 1 REF: EX 263

15. When the Subtotals feature "outlines" your worksheet, by default, the highest level is active. 
_________________________

ANS: T PTS: 1 REF: EX 266

MATCHING

Identify the letter of the choice that best matches the phrase or definition.
a. table g. filter
b. field h. PivotTable
c. record i. field name
d. freeze j. sort
e. sort field k. custom list
f. data definition table l. criteria filter

1. A collection of related fields that are grouped together 
2. To keep headings visible as you work with the data in a large worksheet 
3. Documentation that lists the fields to be maintained for each record 
4. A column within an Excel range 
5. Used to group and summarize a list into a concise, tabular format 
6. To temporarily hide all the records that do not meet your criteria 
7. A range of related data managed independently from the data in other rows and columns in the 

worksheet 
8. The field you use to order your data 
9. Indicates the sequence in which you want data ordered 

10. Enables you to specify various conditions in addition to those that are based on an “equals” criterion 
11. A unique label that describes the contents of data in a column 
12. To rearrange records in a table or range based on the data in one or more fields 

1. ANS: C PTS: 1 REF: EX 234
2. ANS: D PTS: 1 REF: EX 238
3. ANS: F PTS: 1 REF: EX 236
4. ANS: B PTS: 1 REF: EX 234
5. ANS: H PTS: 1 REF: EX 268
6. ANS: G PTS: 1 REF: EX 252
7. ANS: A PTS: 1 REF: EX 235
8. ANS: E PTS: 1 REF: EX 235
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9. ANS: K PTS: 1 REF: EX 247
10. ANS: L PTS: 1 REF: EX 256
11. ANS: I PTS: 1 REF: EX 235
12. ANS: J PTS: 1 REF: EX 234

MULTIPLE CHOICE

1. Using Excel, you can ____.
a. store data c. create reports
b. retrieve subsets of data d. all of the above

ANS: D PTS: 1 REF: EX 236   

2. In Excel, a collection of similar data can be structured in a(n) ____ of rows and columns.
a. index c. list
b. glossary d. range

ANS: D PTS: 1 REF: EX 236

3. A data ____ table describes the fields you plan to maintain in a table.
a. structure c. map
b. definition d. linked

ANS: B PTS: 1 REF: EX 236

4. You should ____ the field names to make it easier to Excel to distinguish between the data in the list 
and the field names.
a. boldface c. use a different color for
b. change the font of d. any of the above

ANS: D PTS: 1 REF: EX 237

5. Press ____ to return to cell A1 in a worksheet.
a. Ctrl+Home c. F1
b. Ctrl+Esc d. Alt+Esc

ANS: A PTS: 1 REF: EX 238

6. ____ rows and columns lets you keep headings on the screen as you work with the data in a large 
worksheet.
a. Hiding c. Showing
b. Freezing d. Sealing

ANS: B PTS: 1 REF: EX 238

7. A dark, horizontal line appears ____ the column headers to indicate which row is frozen.
a. above c. both a. and b. 
b. below d. neither a. nor b.

ANS: B PTS: 1 REF: EX 238

8. In Excel, a table is a range of related data that is managed independently from the data in other ____ in
the worksheet.
a. rows and headers c. rows and columns
b. grids and columns d. footers and grids
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ANS: C PTS: 1 REF: EX 235

9. When you designate a range as a(n) ____, Excel provides the same operations as are available for a 
structured range of data.
a. table c. index
b. catalogue d. roster

ANS: A PTS: 1 REF: EX 239

10. To create a table, click the ____ tab on the Ribbon and then, in the Tables group, click the Table 
button.
a. Design c. Insert
b. Home d. View

ANS: C PTS: 1 REF: EX 239

11. Excel assigns the name ____ to the first Excel table created in a workbook.
a. 1 c. NewTable
b. 1Table d. Table1

ANS: D PTS: 1 REF: EX 240

12. Which of the following is NOT a valid table name?
a. New_table c. _Newtable
b. Table2 d. 2Table

ANS: D PTS: 1 REF: EX 240

13. A table name can include all of the following EXCEPT ____
a. numbers c. underscores
b. spaces d. letters

ANS: B PTS: 1 REF: EX 240

14. Referring to the figure above, the icon shown in cell B118 is the ____ button.
a. QuickCorrect c. Quick Filter
b. AutoSort d. AutoCorrect Options

ANS: D PTS: 1 REF: EX 242

15. Referring to the figure above, in row 117, in the last full column shown, there is a small triangle shown
in the bottom-right corner of the cell. This triangle indicates ____.
a. a frozen cell c. an AutoCorrect field
b. a sizing handle d. a sort field

www.ub
oo

kly
.co

m



ANS: B PTS: 1 REF: EX 242

16. As you type in a cell, ____ displays any existing entry in the column that matches the characters you 
typed.
a. QuickFix c. Column Checker
b. AutoComplete d. AutoFill

ANS: B PTS: 1 REF: EX 243

17. After Excel displays an existing entry in the column that matches the characters you typed, press the 
____ key to accept the entry.
a. Shift c. Esc
b. Tab d. Alt

ANS: B PTS: 1 REF: EX 243

18. You can find fields whose contents match a value exactly by clicking the Options button in the Find & 
Replace dialog box, and checking the ____ check box.
a. Exact match c. Complete cell
b. Match entire cell contents d. Precise match to entire cell

ANS: B PTS: 1 REF: EX 244

19. ____ order arranges labels in reverse alphabetical order, from Z to A.
a. Reverse c. Ascending
b. Major d. Descending

ANS: D PTS: 1 REF: EX 244

20. The fields you use to order your data are called sort ____.
a. values c. tags
b. fields d. tools

ANS: B PTS: 1 REF: EX 235

21. You can use up to ____ sort fields in a single sort.
a. 12 c. 32
b. 24 d. 64

ANS: D PTS: 1 REF: EX 245

22. You can access the Sort buttons in the ____ group on the Home tab by clicking the Sort & Filter button
and clicking a sort option.
a. Filtering c. Editing
b. Formatting d. Text

ANS: C PTS: 1 REF: EX 244

23. When you have more than one sort field, you should use the Sort ____ to specify the sort criteria.
a. menu c. wizard
b. status bar d. dialog box

ANS: D PTS: 1 REF: EX 245

24. You can sort by ____.
a. cell color c. cell icon
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b. font color d. all of the above

ANS: D PTS: 1 REF: EX 246

25. To add a sort field in the Sort dialog box, click the ____ button.
a. Add Level c. New Sort Field
b. Add Field d. New Level

ANS: A PTS: 1 REF: EX 245

26. To delete a sort field in the Sort dialog box, click the ____ button.
a. Remove Level c. Descend Level
b. Delete Level d. Delete Field

ANS: B PTS: 1 REF: EX 246

27. Excel provides ____ predefined custom sort lists.
a. three c. six
b. four d. seven

ANS: B PTS: 1 REF: EX 247

28. After data is filtered, you can ____ it.
a. sort c. copy
b. chart d. all of the above

ANS: D PTS: 1 REF: EX 252

29. After you filter a column, the ____ Filter command becomes available so you can remove the filter 
and redisplay all the records.
a. Remove c. Delete
b. Clear d. Archive

ANS: B PTS: 1 REF: EX 252

30. You can display or hide filter arrows for an Excel table by using the Filter button in the Sort & Filter 
group on the ____ tab.
a. Category c. Data
b. View d. Home

ANS: C PTS: 1 REF: EX 252
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31. In the accompanying figure, "Installation," "Sculpture," and "Textile" are all part of the list of ____ 
options.
a. selection c. custom
b. filtering d. query

ANS: B PTS: 1 REF: EX 252

32. The ____ condition requires that all of the selected criteria be true for the record to be displayed.
a. OR c. AND
b. NAND d. IF

ANS: C PTS: 1 REF: EX 255

33. The ____ condition requires that only one of the selected criteria be true for a record to be displayed.
a. NAND c. AND
b. OR d. IF

ANS: B PTS: 1 REF: EX 255

34. Criteria filters allow you to specify relationships other than those that are based on a(n)  "____" the 
criterion.
a. in c. greater than
b. like d. equals

ANS: D PTS: 1 REF: EX 256

35. You use ____ filters to find all objects with a value greater than X or acquired after a certain date.
a. custom c. index
b. criteria d. pivot

ANS: B PTS: 1 REF: EX 256

36. The ____ criteria filter requires the records displayed to start with the specified text string.
a. Origin c. Initial
b. Begins With d. Start

ANS: B PTS: 1 REF: EX 256

37. The ____ criteria filter requires the records displayed to have the specified text string anywhere.
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a. Has c. Contains
b. Is d. Matches

ANS: C PTS: 1 REF: EX 256

38. The ____ criteria filter requires the records displayed not to have the specified text string anywhere.
a. Does Not Have c. Does Not Match
b. Is Not d. Does Not Contain

ANS: D PTS: 1 REF: EX 256

39. The ____ criteria filter requires the records displayed to be greater than or equal to and less than or 
equal to the specified numbers.
a. Top 10 c. Aggregate
b. Between d. Range

ANS: B PTS: 1 REF: EX 256

40. The ____ filtering option displays the top or bottom 10 (or specified number) items in a list.
a. Bottom 10 c. Custom
b. Top 10 d. All

ANS: B PTS: 1 REF: EX 256

41. The ____ criteria filter requires the records displayed to have the current date.
a. Current Date c. This
b. This Date d. Today

ANS: D PTS: 1 REF: EX 256

42. The ____ criteria filter requires the records displayed to be since January 1 of the current year to the 
current date.
a. Year to Date c. Current
b. Today d. none of the above

ANS: A PTS: 1 REF: EX 256

43. With the Last Quarter criteria filter, quarters are defined as, for example, ____.
a. April, May, June c. May, June, July
b. March, April, May d. March, April, May, June

ANS: A PTS: 1 REF: EX 256

44. When you click in each cell in the Total row, a(n) ____ appears that you can click to open a list of the 
most commonly used functions.
a. menu c. button
b. arrow d. status bar

ANS: B PTS: 1 REF: EX 259

45. You can split the worksheet window into ____ separate panes.
a. two or four c. six or eight 
b. four or six d. all of the above

ANS: A PTS: 1 REF: EX 261
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46. You select the ____ option button in the Custom AutoFilter dialog box if you want to display rows that
meet both of two criteria.
a. Or c. And
b. Both d. Either

ANS: C PTS: 1 REF: EX 257

47. You select the ____ option button in the Custom AutoFilter dialog box if you want to display rows that
meet either of two criteria.
a. Or c. And
b. Both d. Either

ANS: A PTS: 1 REF: EX 257

48. In the figure above, if you only want to set one criterion for this filter, you’ll ____.
a. leave the lower boxes empty c. enter “none” into the lower boxes
b. enter “0” into the lower boxes d. access a pull-down menu of options

ANS: A PTS: 1 REF: EX 257

49. In the figure above, the 20,000 indicates the price of a piece of artwork. Records with artwork with the
following values meet the criteria: ____.
a. $19,999 c. $20,001
b. $20,000 d. all of the above

ANS: C PTS: 1 REF: EX 258

50. When you click in each cell in the ____ row, an arrow appears that you can click to open a list of the 
most commonly used functions.
a. Total c. Function
b. Group d. Header

ANS: A PTS: 1 REF: EX 259

51. You can click the More Functions command on the Total arrow button list to open the ____ dialog box 
and select any available function.
a. Display Function c. Add Function
b. Insert Function d. New Function

ANS: B PTS: 1 REF: EX 260

www.ub
oo

kly
.co

m



52. The Subtotals command offers summary information such as ____.
a. counts c. averages
b. sums d. all of the above

ANS: D PTS: 1 REF: EX 263

53. To calculate subtotal for a table, the first step is to use the ____ button on the Table Tools Design tab.
a. Expand for Calculation c. Summary
b. Convert to Range d. Function

ANS: B PTS: 1 REF: EX 263

54. The three ____ buttons at the top of the outline area allow you to show or hide different levels of detail
in the worksheet.
a. Expansion c. Summary
b. Outline d. Function

ANS: B PTS: 1 REF: EX 266

55. In addition to displaying subtotals, the Subtotal feature "____" your worksheet so you can control the 
level of detail that is displayed.
a. headers c. shadows
b. outlines d. defines

ANS: B PTS: 1 REF: EX 266

56. A PivotTable summarizes data in different categories using functions such as ____.
a. SUM c. MIN
b. AVERAGE d. Any of the above

ANS: C PTS: 1 REF: EX 270

57. One advantage of PivotTables is that you can easily ____ different categories in the PivotTable to 
provide alternative views of the data.
a. rearrange c. display
b. hide d. any of the above

ANS: D PTS: 1 REF: EX 270

58. The PivotTable button is available in the Tables group on the ____ tab.
a. Format c. Home
b. Design d. Insert

ANS: D PTS: 1 REF: EX 272

59. PivotTable data can be a(n) ____.
a. an Access database file c. an Excel range in the current workbook
b. an Excel table in the current workbook d. any of the above

ANS: D PTS: 1 REF: EX 272

60. You can create a PivotTable by clicking the Summarize with PivotTable button in the Tools group on 
the ____ tab.
a. Home c. Table Tools Design
b. View d. PivotTable

ANS: C PTS: 1 REF: EX 272
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61. On the far right, in the figure above, there is the PivotTable field list.  The items listed there, such as 
“Artist” and “Title” are ____ in the ArtObjects table.
a. columns c. chart data labels
b. rows d. field values

ANS: A PTS: 1 REF: EX 273

62. On the bottom-right corner of the figure above, there are four squares labeled Report Filter, Column 
Labels, Row Labels, and Values. These four areas represent the ____ of the PivotTable.
a. files c. segments
b. categories d. layout

ANS: D PTS: 1 REF: EX 273

63. To get to the screen shown in the figure above, you would click the Insert tab on the Ribbon, and then, 
in the ____ group, click the PivotTable button.
a. Tables c. Tools
b. PivotTables d. Data

ANS: A PTS: 1 REF: EX 273

64. The worksheet you are viewing is “Sheet1.” To set the PivotTable in its own sheet all of the following 
are true EXCEPT: 
a. In the Create PivotTable dialog box, make sure the Select a table or range option button is 

selected.
b. In the Create PivotTable dialog box, make sure the correct name for the range appears in 

the Table/Range box.
c. Click the New Worksheet option button.
d. In the Create PivotTable dialog box, a new worksheet, Sheet1, is inserted to the right of the

current worksheet.

ANS: D PTS: 1 REF: EX 273
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65. In laying out the PivotTable on the worksheet, you can drag the Condition field button from the Row 
Labels box to the Column Labels box. The PivotTable is rearranged so that the Condition field is a 
____ label.
a. column c. range
b. row d. filter

ANS: A PTS: 1 REF: EX 278

66. By default, the PivotTable report uses the ____ function for numbers in the Values area.
a. COUNT c. MIN
b. AVERAGE d. SUM

ANS: D PTS: 1 REF: EX 274

67. You can point to any style in a gallery to see a ____ of the PivotTable with that style applied.
a. Demo c. Live Preview
b. AutoView d. Snapshot

ANS: C PTS: 1 REF: EX 276

68. You can use the ____ tab to change the SUM function to a different summary function, in a 
PivotTable.
a. New Function c. Summarize Values by
b. Change Function d. Summary function

ANS: C PTS: 1 REF: EX 277

69. The ____ report layout displays one column for each field and leaves space for column headers.
a. Outline c. Tabular
b. Design d. Headers

ANS: C PTS: 1 REF: EX 278

70. You cannot change data directly in the PivotTable. Instead, you must edit the Excel table, and then 
____, or update, the PivotTable to reflect the updated data.
a. reset c. renew 
b. refresh d. change

ANS: B PTS: 1 REF: EX 287

Case-Based Critical Thinking Questions

Case 5-1
You are tutoring a fellow student who is new to the more advanced features of Excel..

71. Your tutee has a lot of familiarity with ranges from an earlier Excel class, but he knows that there is an 
alternative that will give him access to additional features that he does not have with a cell range. What
is that option?
a. Convert the range to a table.
b. Convert the range to an index.
c. Convert the range to a PivotChart.
d. The tutee is wrong; the range has any many features as any Excel alternative.

ANS: A PTS: 1 REF: EX 239 TOP: Critical Thinking 
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72. Which of the following is NOT a feature that is unique to Excel tables (as opposed to structured ranges
of data)?
a. You can format quickly using a table style.
b. You can enter a formula in one table cell that is automatically copied to all other cells in 

that table column.
c. You can add new rows and columns that automatically expand the range.
d. You can freeze the top row of the worksheet.

ANS: D PTS: 1 REF: EX 238 TOP: Critical Thinking 

Case-Based Critical Thinking Questions

Case 5-2
Simon has just discovered the power of using text filters to control which records display in his 
worksheet, and he has begun to use them often to find precisely the records he needs. The following 
questions are based on a staff directory table that includes First Name, Last Name, Office Number, 
Department Name, and Phone Number.

73. If Simon wants to find all of his colleagues named Joseph, Joanne, and Josephine, what should he do?
a. Create a text filter using the Begins With operator to display all records that have Jo at the 

beginning of the text value.
b. Create a text filter using the Contains operator to display all records that have Jo at the 

beginning of the text value.
c. Create a text filter using the Begins With operator to display all records that have Jos at the

beginning of the text value.
d. Create a text filter using the Contains operator to display all records that include Jo in the 

text value.

ANS: A PTS: 1 REF: EX 256 TOP: Critical Thinking

74. If Simon wants to find all of his colleagues whose last names end in “berg” (such as Goldberg and 
Steenberg), what should he do?
a. Create a text filter using the Ends With operator to display all records that have dberg as 

the last characters in the text value.
b. Create a text filter using the Contains operator to display all records that include berg in 

the text value.
c. Create a text filter using the Ends With operator to display all records that have berg as the 

last characters in the text value.
d. Create a text filter using the Contains operator to display all records that have berg as the 

last characters in the text value.

ANS: C PTS: 1 REF: EX 256 TOP: Critical Thinking 

75. To find anyone whose department name is either Transaction Processing, Processing Operations, or 
Records Processing, what should he do?
a. Create a text filter using the Contains operator to display all records that have Operations 

anywhere in the text value.
b. Create a text filter using the Ends With operator to display all records that have Processing 

as the last characters in the text value.
c. Create a text filter using the Begins With operator to display all records that have 

Processing as the first characters in the text value.
d. Create a text filter using the Contains operator to display all records that have Processing 

anywhere in the text value.

ANS: D PTS: 1 REF: EX 256 TOP: Critical Thinking 
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Critical Thinking Case-Based Questions

Case 5-3
As she prepares her assignment for her Business Management class, Jamie goes to her friend Charlie 
for help with PivotTables because he has had a lot of experience with them in his job.

76. Which of the following is NOT a true statement Charlie can make to Jamie about PivotTables?
a. To remove a field from a PivotTable, you click the field’s check box in the PivotTable 

Field list.
b. You can rename a value label by typing the new text directly in any cell where the value 

label appears in the PivotTable.
c. Removing a field from the PivotTable changes the underlying Excel table.
d. All of the above statements are true.

ANS: C PTS: 1 REF: EX 284 TOP: Critical Thinking 

77. Jamie wants to be able to analyze date data in her PivotTable by month. What must she do with the 
date field in her PivotTable?
a. She must aggregate the data by the date field.
b. She must cluster the data by the date field.
c. She must sort the data by the date field.
d. She must group the data by the date field.

ANS: D PTS: 1 REF: EX 288 TOP: Critical Thinking

78. If Jamie decides that she wants to work with nonnumeric data in her PivotTable, what function must 
she use to produce summaries?
a. SUM c. TOTAL
b. AGGREGATE d. COUNT

ANS: D PTS: 1 REF: EX 291 TOP: Critical Thinking 

79. Jamie wants to be able to use her PivotTable to combine items into groups. Which of the following is 
NOT true?
a. Items that appear as row labels cannot be grouped.
b. Items that appear as column labels can be grouped.
c. If items are dates, they can be grouped automatically using the Grouping dialog box.
d. If items are numbers, they can be grouped manually using the Ctrl key to select items in a 

group and then choosing Group from the shortcut menu.

ANS: A PTS: 1 REF: EX 291 TOP: Critical Thinking

80. Jamie wants to use her PivotTable to show the total value of the cars for a series of car dealerships but 
she wants to filter the display to show only those dealers whose total stock of cars is greater than $1 
million. How would she accomplish this?
a. She would develop a PivotTable using the aggregate filter.
b. She would develop a PivotTable using the report filter.
c. She would develop a PivotTable using the category filter.
d. She would develop a PivotTable using the value filter.

ANS: D PTS: 1 REF: EX 291 TOP: Critical Thinking 

COMPLETION
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1. When related fields are grouped together in a row, they form a(n) ____________________, a 
collection of fields that describes a person, place, or thing.

ANS: record

PTS: 1 REF: EX 234

2. Each column in a range represents a(n) ____________________ that describes some attribute or 
characteristic of a person, place, or thing.

ANS: field

PTS: 1 REF: EX 234

3. The top row of a range should contain a(n) ____________________ name.

ANS: field

PTS: 1 REF: EX 237

4. Separate the data (including the header row) from other information in the worksheet by at least 
________________ blank row and one blank column.

ANS: one

PTS: 1 REF: EX 237

5. To freeze a row, select the cell below the row(s) you want to freeze, click the ____________________ 
button in the Window group and then click Freeze Top Row.

ANS: Freeze Panes

PTS: 1 REF: EX 238

6. The second sort field in a sort is called the ____________________ field.

ANS: secondary sort

PTS: 1 REF: EX 245

7. Typically, you want to sort by the numbers, text, or dates stored in the cells, which are all 
____________________.

ANS: values

PTS: 1 REF: EX 246

8. A(n) ____________________ list indicates the sequence in which you want data ordered.

ANS: custom

PTS: 1 REF: EX 247
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9. The process of hiding certain records and viewing the ones you want is called 
____________________ your data.

ANS: filtering

PTS: 1 REF: EX 252

10. When you want to see all the data in a filtered table, you can ____________________, or remove, the 
filters.

ANS: clear

PTS: 1 REF: EX 255

11. The ____________________ criteria filter requires that the records displaying begin with the specified
text string.

ANS: Begins With

PTS: 1 REF: EX 256

12. The entry 20000 is the ________________ for the first condition.

ANS: criterion

PTS: 1 REF: EX 258

13. The ____________________ command automatically inserts a subtotal line into the range for each 
group of data.

ANS: Subtotals

PTS: 1 REF: EX 263

14. A(n) ____________________ is an interactive table that enables you to group and summarize an 
Excel list into a concise, tabular format for easier reporting and analysis.

ANS: PivotTable
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PTS: 1 REF: EX 268

15. In PivotTable terminology, the fields that you summarize are known as ____________________ fields.

ANS: value

PTS: 1 REF: EX 270

16. In addition to data fields, a PivotTable uses ____________________ fields to groups values such as 
department, model, year, and vehicle type in an automobile-related sheet, for example.

ANS: category

PTS: 1 REF: EX 270

17. The box that is covering columns A, B, and C in the figure above is the PivotTable ________________
area.

ANS: report

PTS: 1 REF: EX 273

18. The benefit of a(n) ____________________ is that it summarizes large amounts of data into a readable
format.

ANS: PivotTable

PTS: 1 REF: EX 277

19. A(n) ____________________ filter allows you to filter the PivotTable to display summarized data for 
one or more field items or all field items in the Report Filter area.
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ANS: report

PTS: 1 REF: EX 279

20. A(n) ____________________ is a graphical representation of the data in a PivotTable.

ANS: PivotChart

PTS: 1 REF: EX 268

ESSAY

1. What are the guidelines for creating an effective structured range of data?

ANS:
* Enter field names in the top row of the range. A field name (column header) is a unique label that 
describes the contents of the data in that column. The row of field names is called the header row. 
Although the header row often is row 1, it can be any row.
* Use short, descriptive field names. Shorter field names are easier to remember and enable more 
fields to appear in the workbook window at once.
* Format field names to distinguish the header row from the data. For example, apply bold, color, and 
a different font size.
* Enter the same kind of data for a field in each record.
* Separate the data from other information in the worksheet by at least one blank row and one blank 
column. The blank row and column enable Excel to accurately determine the range of the data.

PTS: 1 REF: EX 237 TOP: Critical Thinking

2. What are the steps for sorting data using multiple fields?

ANS:
Click any cell in a table or range. In the Sort & Filters group on the Data tab, click the Sort button to 
open the Sort dialog box. If the Sort by row exists, modify the primary sort by selections; otherwise, 
click the Add Level button to insert the Sort by row. Click the Sort by arrow, select the column heading
that you want to specify as the primary sort field, click the Sort On arrow to select the type of data, and
then click the Order arrow to select the sort order. To sort by a second column, click the Add Level 
button to add the first Then by row. Click the Sort by arrow, select the column heading that you want 
to specify as the secondary sort field, click the Sort On arrow to select the type of data, and then click 
the Order arrow to select the sort order. To sort by additional columns, click the Add Level button and 
select appropriate Then by, Sort On, and Order values. Click the OK button.

PTS: 1 REF: EX 245 TOP: Critical Thinking

3. What is a PivotTable? Describe its use in Excel, including the definition of value fields and category 
fields.

ANS:
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A PivotTable is an interactive table that enables you to group and summarize an Excel list into a 
concise, tabular format for easier reporting and analysis. A PivotTable summarizes data in different 
categories, using functions such as COUNT, SUM, AVERAGE, MAX, and MIN. To generate a 
PivotTable report, you need to specify which fields you want to summarize; in PivotTable terminology,
these fields are known as data fields. In addition to value fields, a PivotTable uses category fields to 
group values. Category fields appear in PivotTables as row labels, column labels, and report filters, 
which allows you to focus on a subset of the PivotTable by displaying one, several, or all items.

PTS: 1 REF: EX 268 | EX 270 TOP: Critical Thinking
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